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Objectives

« Set document margins

* Create sections and columns
* |nsert page breaks

* |Insert page numbers

« Add headers and footers
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Objectives

 Insert a table
 Add footnotes and endnotes
 |nsert citations

 Manage sources and create a
bibliography
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' Set Document Margins

« Document margins are the blank
areas between the edge of the text
and the edge of the page

» Default margins are 1" at the top,
bottom, left, and right sides of the page

» Changing a document’s margins
changes the amount of text that fits on

a page

Microsoft Office Word 2013 - Illustrated Complete



Set Document Margins

« Page orientation

» Portrait orientation means a page Is
taller than it i1s wide

* The default page orientation for a
document is portrait

» Landscape orientation means a page Iis
wider than it is tall

« Paper size
» Default paper size is 8.5" x 117
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Select gutter position

Set mirror margins and other
page layout options

Preview of margin settings

Select part of document
to apply settings to



Set Document Margins
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' Set Document Margins

« Margin options in a multiple page
; document

* Mirror margins are used in documents with
facing pages, such as magazines
 Inside and outside margins are a mirror image of
each other
A gutter margin is used in documents that are
bound, such as books

'
‘
0
/ "
y" « A gutter adds extra space to the top, left, or inside
margin to allow for the binding
« Set mirror margins and a gutter on the
i

Margins tab of the Page Setup dialog box
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' Create Sections and Columns

« A section Is a portion of a document that is
separated from the rest of the document
by section breaks

A section break is a formatting mark that
| shows the end of a section

‘ * You divide a document into sections when you
' | want to apply different page layout settings,
,‘ such as columns, to sections

« Sections are used to vary the layout of a document

« A document is formatted in a single section by
default

Microsoft Office Word 2013 - Illustrated Complete



Create Sections and Columnsc

Insert a section break using the Breaks
button in the Page Setup group on the
Page Layout tab

« Types of section breaks:

section function

Next page Beqins a new section and moves the text following the break to the top of the next page

Continuous Begins a new section on the same page

Even page Begins a new section and moves the text following the break to the top of the next even-numbered page
Odd page Beqins a new section and moves the text following the break to the top of the next odd-numbered page
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' Create Sections and Columns

« Changing page layout settings for a
section

« Each section in a document can have different
page layout settings

| « Margins, page orientation, paper size, headers and

,, footers, page numbering, vertical alignment, etc.
« To apply page layout settings to an individual

' section, make sure to click the Apply to list
{ arrow in the Page Setup dialog box, and then
click This section

Microsoft Office Word 2013 - Illustrated Complete 12



Insert Page Breaks

As you type, an automatic (soft) page
break Is automatically inserted when you
reach the bottom of a page

« Text flows to the next page

* You can force text onto the next page by
Inserting a manual (hard) page break

« Use the Breaks button in the Page Setup

group on the Page Layout tab to insert a page
break, or

* Press [Ctrl][Enter]

 |nsert column breaks to force text to the
top of the next column
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Insert Page Breaks

Insertion point
on page 2 of
document
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Manual page break appears as a dotted line in Print
Layout view when formatting marks are displayed

Text that follows break is
forced onto the next page
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Insert Page Breaks

« Types of breaks

break function
Page Forces the text following the break to begin at the top of the next page
Column Forces the text following the break to begin at the top of the next column

Text Wrapping Forces the text following the break to begin at the beginning of the next line

Microsoft Office Word 2013 - Illustrated Complete
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Insert Page Numbers

« Automatically number the pages of a
document by inserting a page number field

A field is a code that serves as a placeholder
for data that changes in a document

|

A

'

| * For example, page numbers or the current date
,, | * Click the Page Number button in the Header &

Footer group on the Insert tab to insert a page
' | number field
,b « Select a location, such as bottom of page
» Select a preformatted page number and alignment
|
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Insert Page Numbers

« Page number fields are inserted in a
document header or footer

Document text is Page number field

dimmed when —> - ; e i e |
- : .. . ‘ / in Foater area

Page 1 of document :

2
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Insert Page Numbers
l

I
)

4 - Moving around in a long document
A * Scroll using the scroll bars
|

* Browse by Object button below the
vertical scroll bar

« Select object to browse by from the palette
of object types

i

. « Object types include next or previous

page, section, table, graphic, or other item
of the same type

\ Microsoft Office Word 2013 - Illustrated Complete 18



Insert Page Numbers

* |nsert Quick Parts

 Insert a Quick Part field, such as a field for the
current date or current time

 Insert a field for document property information,
such as author and title

« Content in field automatically updates each time
you open the document

« Word uses your computer clock to compute the
current date and time
 Click the Quick Parts button in the Text group
on the Insert tab, click Field on the menu, click
the field name in the Field dialog box

Microsoft Office Word 2013 - Illustrated Complete 19



Add Headers and Footers

 Add headers and footers to a document
! when there Is an item you want to appear
on every page

* A header is text or graphics that appears at

the top of every page of a document
A footer is text or graphics that appears at the
bottom of every page of a document

Headers and footers often contain
Information such as document title, author
name, dates, and page numbers

Microsoft Office Word 2013 - Illustrated Complete 20
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| Add Headers and Footers

' |

3 ,  Open the Header and Footer areas by:
,' 4
‘

« Clicking the Header button or the Footer
button on the Insert tab

* Double-clicking an existing header or footer

« Choose from several built-in header and
footer designs

\ Microsoft Office Word 2013 - Illustrated Complete 21



' Add Headers and Footers

 Document text is dimmed when the
Header and Footer areas are open

« Dimmed text can’t be edited
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document margins

Document text
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| Add Headers and Footers

‘ |
4

'l « Create different headers and footers:
: J ! » For the first page of a document or

—

section
 For each section in a document

* For even- and odd-numbered pages in
a document or section

%
!
;
!‘ « Use the Header & Footer Tools

¥
)

Design tab to edit headers and
footers
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' Add Headers and Footers

 Create custom Headers and Footers
as reusable building blocks

e To save

« Select all the text including the last
paragraph mark

i

* Click the Header (or Footer) button

! * Click Save Selection to Header (or
‘ Footer) Gallery

 Complete the Create New Building
Block dialog box

|, Microsoft Office Word 2013 - Illustrated Complete 24



Insert a Table

 Tables illustrate information intended
for quick reference and analysis

A table is a grid of columns and rows
that you can fill with text and graphics

* A cellis the box formed by the intersection
of a column and a row

|

%
0

!
' » Borders are the lines that divide the rows
‘V‘ and columns of a table and help you see

the structure
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Insert a Table

« Completed table in a document

long pants and long-skeeved shans, and apply n msec!t | Sswree; (Centers for Disease Control and Prevention) |
repellent that contams DEET.

Preventive Options for Serious Travel Health lssues

-

Vaccine Prophylaxis Drug Eat and Drink Safely Avodd Insects

Alalaria ¥ o
Tvphaid v v
Hipatitis A v
Cholera v +
' b

Japanese Encephalitis

Your table may show nonprinting
gridlines between columns

Microsoft Office Word 2013 - Illustrated Complete
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' Add Footnotes and Endnotes

* Footnotes and endnotes provide
additional information
* They consist of two parts

* Note reference mark
» Corresponding footnote or endnote

* Footnotes are placed at the end of
each page below a separator line

* Endnotes are placed at the end of
the document

Microsoft Office Word 2013 - Illustrated Complete
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Add Footnotes and Endnotes
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The medical profession and the travel industry are an
important source of help and advice for travelers, how-
ever, it is the responsibility of the traveler to seek ot
information on travel-related risks, understand the fac-
tors involved, and take the necessary precautions.

Travel-related Risks

The following are key factors in determining the risks to
which travelers may be exposed:

destination and mode of transportation
purpose, duration. and season of travel
standards of accommodation and food hygiene
behavior and health of the traveler

Separator line

g

' Behavior is a critical factor. For example, going outdoors
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sician at least 4-8 weeks before the journey, and prefes-
ably earlier for long-term travel or travel 10 remote ar-
eas. Last minute travelers should also consult a clinic or

physician

A medical consultation is needad to determine the need
for vaccinations and antumalanal medication, as well as
any other medication the waveler may require. Medical
advisors base their recommendations on an assessment
of nisk for the individual traveler as well as any associ-

e PR~ Note reference
mark

< It 1s best to consult a travel medacine specialist |

inn a malania-endemic area could result mb-ecanmgmfect%t\/

Footnote text

Vot v 5.+ |1
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Insert Citations

‘ " « Use the Word References feature to
' I keep track of reference sources
| * Insert a citation into a document

* A citation gives credit to the source of a
guotation or other information used In a

[
%
0
4
document
« Usually includes author name and page
‘ number
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Insert Citations

*Adding a Report source

Type of Source | Report vl
Bibliography Fields for MLA

Author |
|| Corporate Author  \World Tourism Organization
Title Towrism Highlights
Year 2015

Publisher “World Towrism Organization

City |Madrid
Repaort Type _wnrtrPaper
Medium | Print

[ ] show ANl Bibliography Fields
Isgname ~ Example: Document  Your fag name

Wﬂr"i f:'l - may differ

Microsoft Office Word 2013 - Illustrated Complete
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' Manage Sources and Create a
“| Bibliography

« A bibliography is a list of sources

used In creating a document
* The works cited list includes the

works cited in the document
« Use the Source Manager dialog box

to organize your sources

Microsoft Office Word 2013 - Illustrated Complete
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' Manage Sources and Create a
Bibliography

The Source Manager dialog box

Your Master List will

List of sources
contain the two " — X associated with the
sources you added and — o - document
either 10 adton — e
sources or different e T Oy e | e e e e g
additional sources o el e
Preview of the citation e fﬂ:;ﬁ ;‘r'k‘"h:ve
ent; "f:‘ 2#2':5:':2: Chaen ravesasc: - a citation in the
= Seswcgmoy Loty document
source in MLA style AR s P L et TE1S . St 353 J
(as defined by Word)
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« The page-formatting features of Word
allow you to creatively lay out and design
the pages of documents:

« Change margins

| Vary the layout of a document by creating and
formatting sections and columns

Insert page and column breaks
Add page numbers

Add headers and footers
Insert a table

s - <

' Microsoft Office Word 2013 - Illustrated Complete 33



 Add footnotes and endnotes to a
document

 Manage references and citations
« Create citations

 Manage sources
* Insert a bibliography

Microsoft Office Word 2013 - Illustrated Complete

34



